
Vous aussi contribuez à créer une carte libre et gratuite : 

Tutoriel débutant sur le « Comment faire pour améliorer 
OpenStreetMap avec JOSM »
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I] Avant propos
Avoir  un  GPS  pour vos  randonnées,  vos  sorties  nature,  ou en voiture c'est  quand 
même un luxe, même si je suis d'accord pour dire que c'est la boussole du XXI siècle 
(sauf quand on a plus de piles ou de batterie) !  Au-delà du fait de posséder un GPS 
avec  lequel  vous pouvez vous repérer  et  vous diriger  grâce  à  des  repères  appelés 
Waypoint, il est préférable (et plus agréable) de posséder une carte. Cette carte doit 

être précise mais aussi  régulièrement mise à jour. Tout cela a forcément un coût. Des produits 
existent pour les sports de nature comme pour la voiture. Garmin propose notamment  la carte 
Garmin* Topo V2 France mais, à  100 € le quart de France, cela peut en faire réfléchir plus 
d'un... 

*L'IGN (Institut géographique national) propose aussi des services similaires.

Aujourd'hui,  avec  la  démocratisation  des  GPS,  des  technologies  Internet  et  de  l'habileté  des 
utilisateurs, chacun peut agir pour des projets communautaires. Dans le monde de la carte libre et 
gratuite, un projet s'est créé pour répondre à ce besoin : OpenStreetMap ! A savoir que ce projet 
existe aussi pour cartographier les océans (OpenSeaMap...). Si vous souhaitez en savoir plus  sur 
ce projet, je vous invite à lire la page  Wikipédia dédiée. L'article « Comment participer » selon 
OpenStreetMap peut être aussi intéressant pour vous faire une idée du fonctionnement du système.

Au départ,  il  s'agit d'utiliser son GPS pour relever les  routes,  les  rues  et les  chemins  en leurs 
donnant des caractéristiques (ex : son nom) mais aussi des objets comme des arrêts de bus, des 
feux  rouges...  et  croyez  moi,  les  possibilités  sont  innombrables !  Cette  base  de  données  est 
accessible gratuitement par tous. Ainsi, vous pourrez utiliser les données brutes ou traitées pour 
par exemple communiquer en géolocalisant votre entreprise, votre festival, en créant des cartes 
de randonnées... Le grand intérêt de ce projet est qu'il est communautaire et donc tout le monde 
travail dans un objectif commun : celui d'avoir une carte exploitable librement et gratuitement ! 

Avec ces données, des services se créent. Un bel exemple est celui d'un site qui utilise ces données 
pour créer des cartes prêtes pour votre GPS Garmin. Je développe l'astuce au travers de la question 
FAQ : Comment avoir des cartes gratuites du monde pour les GPS garmin ? Il ne vous restera plus 
qu'à faire de belles balades et de compléter les sentiers non présents à votre retour ! 

http://fr.wikipedia.org/wiki/OpenStreetMap
http://www.partir-en-vtt.com/php/faq/voir_faq.php?groupe_faq=7
http://www.openstreetmap.fr/participer


II] Introduction

A travers  cet  article  qui  se  veut  être  un  tutoriel pour  les  débutants souhaitant  s'initier  à  la 
contribution pour OpenStreetMap via JOSM, je vais essayer de faire de mon mieux afin de vous  
donner les clés et l'envie de contribuer a ce projet fantastique qu'est OSM (OpenStreetMap). 

Chronologiquement, nous allons tout d'abord approcher le logiciel nous permettant de contribuer à 
la base de données. Du nom de JOSM pour ( éditeur Java pour OpenStreetMap), ce logiciel libre 
va grandement nous faciliter la vie ! Ensuite, nous regarderons la méthode pour contribuer sans 
GPS via le plugin Cadastre. Puis, la méthode avec GPS sera abordée. Enfin, nous verrons comment 
valoriser  nos  données  en  créant  une  belle  carte  qui  pourra  être  utilisée  par  la  suite  pour 
communiquer. Quelques astuces viendront parfaire le tout afin de clôturer ce tutoriel. 

Et si je n'ai pas de GPS puis-je participer ?

C'est  une  bonne question  que  voilà.  La  réponse  est  claire :  c'est  « OUI » !  En  effet  la  DGFiP 
(Direction Générale des Finances Publiques) est une structure publique gérant les impôts fonciers. 
Pour gérer correctement cet impôt,  une cartographie précise des terrains  et  des bâtiments  a été 
produite. Pour la petite histoire, le cadastre Français a été initié à l'époque Napoléonienne.

Le cadastre donne un accès à une carte assez homogène de toute la France. Pour faciliter la vie des 
contributeurs d'OSM, un utilisateur a donc demandé l'autorisation d'utiliser ce fameux cadastre. 
Dans un élan de générosité, la DGFiP a donné son accord pour que chacun puisse « dessiner » de 
façon précise les routes, les bâtiments, les cours d'eau... autour de chez lui en s'aidant du cadastre. 

C'est d'autant plus intéressant que les GPS ne sont pas très précis dans les secteurs urbanisés où les 
bâtiments empêchent une bonne réception satellitaire. De ce fait, je vais dans un premier temps 
vous apprendre à créer la carte de votre quartier, de votre village et pour les plus fou d'entre vous, 
de votre ville et ce, sans dépenser le moindre centimes ! Pour les heureux possesseur de  GPS, 
nous verrons plus tard que l'utilisation de cet outil puissant sera plus intéressant sur des zones où le 
cadastre n'est pas la panacée (sentier de randonnée...).

Une autre méthode, elle aussi  gratuite sera abordée. Il s'agira d'utiliser l'imagerie de Bing. Cette 
méthode, plus didactique car visuelle, vous plaira j'en suis sûr !

Il ne nous reste plus qu'à entrer dans le vif du sujet pour que, très rapidement, votre commune, votre 
quartier ou vos chemins de randonnées favoris se retrouvent sur OpenStreetMap. Vous êtes prêt ? 
Alors, c'est parti !

NLDR     :   Pour des raisons de rapidité, je vais dorénavant utiliser l'acronyme  OSM pour signifier 
OpenStreetMap. Merci de votre compréhension !



III] État des lieux et définition de votre objectif

Pour appréhender votre travail, il est bon de se donner un objectif. Par expérience, mieux vaut ne 
pas être trop ambitieux afin de ne pas être découragé face à l'ampleur du travail à effectuer. Ainsi, je 
vous recommande de travailler sur un secteur que vous connaissez. L'idéal est de travailler sur le 
secteur où l'on habite ou qu'on connaît bien. Choisissez donc de préférence votre quartier ou votre 
village s'il est petit. Faire plus petit comme la route devant chez vous peut tout aussi bien faire 
l'affaire ! Attention par-contre car essayer OSM, c'est l'adopter ! Je vous ai prévenu :) De plus, la 
motivation étant contagieuse,  essayez de convaincre vos connaissances pour vous aider et  ainsi 
créer un dynamisme sur votre secteur. Vous verrez ensuite que votre travail porte ses fruits lorsque 
sur  openstreetmap.org, vous verrez vos routes, sentiers (...) apparaître ! Pour caricaturer, OSM, 
c'est un peu un jeu de construction mais en bien plus utile !

Pour  ma  part,  mon  objectif  est  de  recenser  toutes  les  rues  de  mon  village  et  ajoutant des 
caractéristiques importantes comme :

• Leurs noms (Ex: Rue du Château), 
• Leurs types (Ex: Départementale, petite rue, chemin...). 

Pour me faire une idée de l'état d'avancement du secteur que je souhaite faire, il suffit d'aller sur le 
site  www.openstreetmap.fr. Je clique sur l'onglet « Voir la carte » et une carte apparaît. Je peux 
aller voir l'endroit que je souhaite modifier ou le lieu de mes futures vacances. Pour ce faire, soit on 
se déplace en bougeant et en zoomant sur la carte soit, en faisant une recherche sur une commune 
particulière. Ma commune s'appelant « Gevingey », j'ajoute dans le formulaire  « Recherche » son 
nom et en cliquant sur le bouton « Ok », l'outil me propose une liste de réponse.  En cliquant sur la 
bonne commune, un zoom automatique est effectué sur celle-ci.
En  zoomant/dézoomant  avec ma  roulette, et en me déplaçant avec un  cliqué/déplacé avec ma 
souris, je remarque avec un certain regret qu'il n'y a pas grand chose de fait sur ma commune. On 
remarque la grande route et les deux petites qui passent au centre du village. Par chance, me voilà 
motiver pour remédier à cette tragédie !

Tragédie     : ma commune est bien vide     !  

http://www.openstreetmap.fr/


IV] Téléchargement, installation et paramétrage de l'outil JOSM

Étape 1 : Télécharger et installer le logiciel gratuit  JOSM.

Selon le système d'exploitation de votre ordinateur, veuillez télécharger et installer le logiciel 
JOSM :
 

• Pour Windows  ,
• Pour Mac  ,
• Pour Linux  .

Pour l'installation, rien de très compliqué en soit, cet outil s'installe comme n'importe quel autre 
outil sur votre système d'exploitation. Pour ma part je suis sous un environnement Windows et en 
quelques « Suivant », l'outil est prêt. Pour Mac, cela doit être similaire à Windows et pour le monde 
Unix, cela se fait très bien en ligne de commande. Pour en savoir plus sur JOSM, rendez-vous sur 
sa page Wikipédia.

Pourquoi  avoir choisi l'outil JOSM     ?  

J'ai choisi l'éditeur  JOSM pour ce tutoriel d'approche à la contribution sur OSM car il possède 
l'énorme avantage de proposer le module cadastre aux utilisateurs Français. Il est aussi d'après moi 
bien réalisé, stable en français et est sans cesse en cours d'amélioration. Merci donc à ses créateurs !
J'ai choisi également d'installer la version Anglaise du logiciel JOSM car j'aime travailler avec les 
outils anglais. Il n'empêche que vous pouvez télécharger JOSM en version Française. Durant ce 
tutoriel, je parlerai des menus en Anglais. Puis j'ajouterai entre parenthèses la traduction française 
pour ceux et celles qui souhaitent utiliser la version Française.  

http://fr.wikipedia.org/wiki/JOSM
http://wiki.openstreetmap.org/wiki/FR:JOSM#Linux
http://josm.openstreetmap.de/download/macosx/josm-macosx.zip
http://josm.openstreetmap.de/download/windows/josm-setup.exe


Étape 2 : Mise en place du « Plugin » (Greffon) cadastre!
Tout l'intérêt du cadastre réside dans le fait que l'on va pouvoir « dessiner »  directement sur l'outil 
en se repérant grâce aux parcelles, bâtiments, aux routes, aux rivières. Nous allons donc être en 
mesure de contribuer sans acheter un GPS et sans dépenser le moindre sou !

Pour ce faire, faites : EDIT => Preferences (Modifier => Préférences) et cliquez sur 
l'onglet  qui  ressemble  à  une  prise  de  courant.  Dans  la  zone  de  texte  « Search » 
(Rechercher) tapez « cadastre ».

Vous verrez alors le « plugin » apparaître puis cliquez sur « Download List » (Télécharger la liste) 
en bas de la fenêtre.  Une fois l'installation effectuée, il suffit de redémarrer le logiciel en le fermant 
puis en l'ouvrant. Votre plugin cadastre est maintenant installé !

Étape 3 : Paramétrages
De nouveau , allez dans Edit => Preferences (Modifier => Préférences) puis cliquez sur l'onglet 
qui représente une grille.

Dans la liste déroulante « Projection method » (Projection), sélectionnez « Lambert 
CC9 zones (France) ».
Puis dans la seconde liste déroulante « Lambert CC zone » (Zone), choisissez votre 
zone selon votre département. Le jura se trouve dans la zone 6 (CC 47), je choisi donc 

la sixième possibilité. 

La carte ci-dessous montre les paramètres à appliquer selon votre département :



Faites alors « Ok » et redémarrer le logiciel. Nous venons de paramétrer ce que l'on appelle « la 
projection ». Cette projection permet de savoir que l'on se trouve en France. 

Le cadastre que l'on va « appeler » via un service web par un protocole appelé « WMS » va venir se 
caler parfaitement. Ces notions théoriques ne sont pas vitales, je vous en parle pour votre culture 
générale. En bref, on va dire «  Eh toi le cadastre de Gevingey, vient voir te mettre en tant que carte 
pour que je dessine les routes ». Le cadastre, de nature obéissante viendra se caler en arrière plan.
Le plus dur est fait ouf ! Fermez la fenêtre des paramétrages et passons aux choses sérieuses !

Cas particuliers     :   Il  en fallait  bien ! Il  faut savoir que le cadastre Français n'a pas encore une 
projection uniforme et exploitable facilement sur l'ensemble du territoire. Dans certains cas, il est 
nécessaire de changer le système de projection et de passer en Lambert 4 zones, puis prendre la 
zone concernée. Pour la Guadeloupe et les autres DOM-TOM, veuillez vous reporter à la page wiki 
OSM dédiée. Comment savoir si ma commune est en Lambert 4 ou 9 zones ? Tout simplement un 
peu plus loin dans le tutoriel.  S'il  le cadastre ne s'affiche pas,  vous reviendrez ici  le passer en 
Lambert 4 zones.

Le second problème est que parfois le cadastre de votre commune n'est pas encore « Vectorisé » 
et/ou pas géolocalisé. C'est à dire (en simplifiant) que votre cadastre n'est pas encore sous forme 
« informatique » et qu'il n'est pas calé dans l'espace. Ce sont des images scannées qu'il faut caler 
dans l'espace manuellement. Ce n'est pas du tout simple pour bien caler ces images. Une méthode 
existe et elle est expliquée sur cette page. Si vous n'y arrivez pas, je vous conseille d'attendre ou de 
prendre un secteur ou le cadastre vectorisé est disponible.  Sinon, veuillez vous rapporter sur la 
partie utilisant l'imagerie Bing Map pour travailler gratuitement comme pour le cadastre. 
En France, 70 % des communes sont vectorisées (Août 2011). Comment savoir si ma commune est 
vectoriée ? Vous le saurez un peu plus loin dans le tutoriel lorsque vous ferez appel au cadastre. Si 
le cadastre apparaît dans le logiciel sans demander la planche cadastrale, c'est que le cadastre de 
votre commune est opérationnel.

NLDR     :   Vous pourrez avoir une idée des statistiques de la vectorisation du cadastre Français en 
passant par la: Page statistiques.

V] Mise en production

Étape 1     :   Import des données des autres utilisateurs

Nous avons regardé tout à l'heure sur le site OSM que sur Gevingey, il y avait déjà des choses de 
faites. Il serait dommage de ne pas profiter de ce que les autres utilisateurs ont déjà produit sur ce 
secteur ! Aussi, il  serait très problématique de recréer une route qui existe déjà dans la base de 
données d'OSM ! 

C'est pourquoi, il est nécessaire d'importer les données existantes grâce au bouton du 
menu représentant une flèche verte vers le bas. 

Automatiquement,  une  fenêtre  s'ouvre  et  vous  demande  la  zone  à  télécharger.  Vous  pouvez 
directement  sélectionner  la  zone  sur  la  carte  (avec  un  cliqué-glissé)  ou  passer  par  l'onglet 
recherche. (Je recommande de prendre une petite zone au départ sinon vous allez partir en courant ! 
Ensuite faites « Download » (Télécharger) et les routes, les voies de chemin de fer... apparaîtront. 
Dans mon cas, il n'y a pas grand chose mis à part la ligne de chemin de fer, la départementale et des 
zones de vignes et de forêts ! C'est déjà ça et cela va nous permettre de nous repérer un peu pour 
compléter ce qu'il manque

http://wiki.openstreetmap.org/wiki/WikiProject_France/Statistiques
http://wiki.openstreetmap.org/wiki/WikiProject_Cadastre_Fran%C3%A7ais/Formats_et_projections#Image
http://wiki.openstreetmap.org/wiki/WikiProject_Cadastre_Fran%C3%A7ais/Formats_et_projections
http://wiki.openstreetmap.org/wiki/WikiProject_Cadastre_Fran%C3%A7ais/Formats_et_projections


Import des données existantes :

Habituez vous à visualiser les données sur JOSM. Cela peut paraître assez rustre au premier abord 
mais au bout de quelques temps, vous vous y habituerez et plus tard, vous y prendrez même goût, à 
ce moment là vous visualiserez la matrice (rires) (NLDR     : Référence au film Matrix...) Enfin, bref, 
dans quelques instants, avec le cadastre, vous vous y retrouverez déjà un peu mieux.

Ces routes sont modifiables et peuvent être utilisées pour accrocher vos nouvelles routes... Mais 
attention, surtout, il faut bien savoir que si vous envoyez des modifications mauvaises, c'est toute la 
communauté qui va s'en retrouver pénaliser. Bien-sûr on pourra modifier par la suite mais pensez-y!

Les  contributions  se  font  donc  dans  un  esprit  de  confiance.  Il  peut  donc  arriver  qu'un  autre 
utilisateur modifie vos données en mieux ou en moins bien. Chaque utilisateur est responsable de ce 
qu'il produit. Bien-sûr, comptez sur la communauté pour vous guider ou vous avertir si vous avez 
fait une mauvaise manipulation. Il peut être bon de savoir qu'il est possible de revenir en arrière sur 
une modification mais essayez tant que possible de ne pas créer de grosses erreurs. Si vous avez un 
gros souci dans le logiciel et que vous n'arrivez pas à le résoudre, évitez d'envoyer les données et 
demander de l'aide en vous inscrivant sur la liste de diffusion Française d'OSM.

Étape 2 : Import du cadastre
Pour  importer  votre  cadastre,  la  manipulation  est 
simple.  Dans  un  premier  temps,  il  faut  zoomer à 
l'endroit où vous voulez qu'il apparaisse. Puis cliquez 
sur  le  nouveau menu « Cadastre »  et  sélectionnez 
« Cadastre  Grab »  (Télécharger  le  Cadastre).  On 
vous demande alors le  village ou la  ville que vous 
souhaitez  importer.  Vous  pouvez  aussi  préciser  le 
département  (utile  si  par  exemple  il  existe  deux 
Gevingey en France).

Pour ma part je tape « Gevingey » et j'indique que 
cela se situe dans le Jura (39). Je fais « Ok » et le 
logiciel  contact le serveur qui  contient  le  cadastre. 
Après un temps de chargement, le cadastre s'ouvre, 
devant vos yeux ébahit ! 

NLDR     :   Si  vous  avez  des  problèmes  d'affichages, 
veuillez vous reporter sur la partie IV, étape 3.

http://openstreetmap.fr/forum#nabble-td6166903


Si  vous  souhaitez  faire  apparaître  un  autre  morceau,  déplacez-vous  et  re-faites  la  même 
manipulation menu « Cadastre » puis « Cadastre Grab » (Cadastre) ou appuyez sur la touche 
F11 de votre clavier. La touche F11 est un vrai bonheur, pensez à l'adopter.

On  y  remarque  les  parcelles en  blancs,  les  bâtiments en  jaunes,  les  sections  cadastrales en 
orange-brun  et  les  contours  communaux en  orange.  C'est  un  peu  pixelisé  selon  l'échelle  de 
visualisation mais ça suffit largement pour créer nos routes. Les routes sont les espaces blancs 
entre  tout  le  reste.  Remarquez  que  les  traits  existants  (en  blanc)  traversent  le  cadastre.  Nous 
sommes donc bien calé.

Étape 3 : Production! 
Vous attendiez  ce  moment  avec  impatience ?  Il  est  temps de passer  à  la  production  qui  est  le 
moment le plus intéressant s'il en est ! Prenez votre temps et suivez bien les explications suivantes.

Pour la création des routes dans JOSM, deux outils vous seront indispensables     :  

• La main permet de modifier les lignes existantes ou que l'on créent en les sélectionnant : 

• La ligne permet de créer de nouveaux tronçons : 

Déplacez vous sur la carte avec un clic droit enfoncé de la souris et en la tirant. Pour zoomer en 
avant ou en arrière, utilisez la roulette (molette) de votre souris. 
Un clic gauche permet de créer un « noeud » et  ainsi commencer la route. Puis déplacez votre 
souris sur la route et faites des petits tronçons que vous produisez grâce à un nouveau clic gauche. 
Sur de grandes lignes droites, il est inutile de multiplier les tronçons et donc les nœuds. Par contre, 
dans  un  virage,  essayer  de  créer  une  courbe  représentant  le  virage  en  créant  plusieurs  petits 
tronçons. Une fois que vous souhaitez arrêter une route faite un double clic gauche ou, utilisez le 
bouton ECHAP.

Exemple de création d'une route avec plusieurs tronçons :

Compliquons un peu l'affaire et imaginons maintenant que nous arrivons à un croisement. La rue 
peut changer de nom, de type (devenir un chemin en pierre et plus en goudron par exemple)...En 
conséquence,  il  va  falloir  séparer  les  tronçons  en  les  « coupants »  ou  les  joignants en  les 
« fusionnants ».



Exemple d'un cas de croisement de trois routes : 

On remarque qu'il y a trois routes qui se 
rejoignent à cet endroit. S'agit t-il de trois 
routes distinctes ou de deux ? Vous êtes 
le seul à le savoir grâce à la connaissance 
du terrain et grâce au cadastre via le nom 
des rues. 

Ici pour ma part, il s'agit de deux routes. 
Pourtant,  j'ai  dessiné  3  routes.   Pas  de 
panique, je vais fusionner deux tronçons 
pour qu'ils n'en représentent plus qu'un. 

Je  vais  donc  sélectionner  les  deux 
tronçons  que  je  souhaite  fusionner  en 

cliquant sur l'outil sélection puis en maintenant la touche « ctrl » je vais faire une multi-séléction 
(Les fan's : Ouah t'es trop fort Loïc !!) Oui je sais, je sais ... (rires).

Une fois ces deux tronçons sélectionnés, je clique alors sur le bouton dans la barre d'outils en haut 
permettant de fusionner les deux tronçons :

 

La  division  fait  l'inverse,  cela  permet  par  exemple  de  couper  un  tronçon  qui  doit  en  réalité 
représenter deux routes différentes. sélectionnez un point dans un tronçon et cliquez sur ce bouton 
pour diviser le tracé afin de faire par exemple deux routes distinctes.

 

Si vous êtes arrivé jusque là, soyez fière de vous, vous avez réussi à créer vos premiers «tronçons»
! Il ne faudrait donc pas s'arrêter, si je puis dire en si bonne route... Imaginez que nous laissions 

cette route fraîchement créée dans cet état. Comment pourrait-on savoir si l'on peut rouler dessus en 
voiture ? Cela pourrait être embêtant si en réalité il s'agit d'un chemin de randonnée. C'est pourquoi, 
dans une carte informatique, pour caractériser les objets il est important d'ajouter ce que l'on appelle 
des  « données  attributaires ».   Ces  données  attributaires,  que  l'on  pourrait  nommer 
« caractéristiques », permettent de qualifier l'objet que nous venons de créer afin que l'on puisse 
exploiter l’information.

Étape 4 : Ajouter des caractéristiques à nos routes !
Créer des routes c'est bien, mais savoir quel est le type de route c'est encore mieux. Nous allons 
donc  voir  comment  ajouter  ces  fameuses  données  attributaires  à  nos  chefs  d'œuvres!  (L'auto 
congratulation est autorisé) !

Il faut savoir qu'il existe plusieurs caractéristiques par type d'objet (et oui nous pouvons créer tout 
un tas de choses dans OSM comme ajouter des cabines téléphoniques...). On se croirait presque 
dans le jeu « Sims©» en gratuit et en bien plus utile!



Une page  wiki  OSM regroupe  tout  ça  parfaitement  :  Page  des  caractéristiques  OSM.  Je  vous 
conseille d'ajouter cette page dans vos favoris car c'est en quelque sorte le livre sacré d'OSM.

A l'intérieur de cette page, je cherche le mot « route » dans mon explorateur (NLDR : ctrl + f) et je 
me rend compte que le terme pour signifier « route » est le mot clé « highway ». Tous les attributs 
sont en Anglais, afin d'harmoniser les informations. Ne vous en faites pas, vous aller vite vous y 
faire. 

Si  l'on regarde  attentivement  le  wiki  Feature  OSM, on remarque qu'il  y  a   plusieurs  types  de  
« highway », des grosses et des plus petites si j'ose dire !

Ma «     highway     » à moi est très petite et se situe dans un village alors je cherche dans le wiki :  

• Est-ce une primary ? « Route nationale, grosse départementale ou artère principale en 
ville » non. 

• Une secondary ? Une tertiary...toujours pas... 

Je  dirais  plutôt  une  « residential ».  En  fait  toutes  mes  rues  sont  des  « residential . Pour  les 
randonneurs et sportifs extérieurs, qui désirent créer des routes pour randonneurs ou vététistes, il 
s'agira d'une « highway » + « track » (chemin ou un 4x4 peut passer) ou « highway » + «path» 
(chemin de randonnée ou VTT).

Vous voyez, c'est très simple surtout grâce à la page wiki (en Français) qui explique le tout en 
ajoutant une photo ! Merci aux créateurs de cette page. 

OK mais où est-ce que je rentre ces informations ?

Bonne question. En fait, il faut cliquer sur la route 
(un  morceau  du  tronçon)  que  vous  souhaitez 

caractériser grâce à l'outil sélection. 

Puis,  à  droite  du  logiciel  il  y  a  un  cadre 
« Properties/membership »  (Propriété => 
Appartenance) et cliquant sur le bouton « Add » 
(Ajouter),  une petite  fenêtre s'ouvre pour ajouter 
ces fameuses caractéristiques ! 

Jetez  aussi  un  coup  d’œil  au  menu  « Pré-
réglages » qui vous permet d'ajouter automatiquement le bon type de route ! Balises => Routes => 
Routes et choisissez le type de route adéquate.

Nous commençons par ajouter le type de rue soit « highway » 
puis en dessous « residential »!

Puis, je souhaite ajouter un nom à la rue. Je clique alors de 
nouveau  sur  « add »  (Ajouter)  pour  dans  la  première  liste 
déroulante taper « name » et en dessous le nom de ma rue. 

Et voilà ma rue a maintenant un nom et est caractérisée en tant 
que route résidentielle.

http://wiki.openstreetmap.org/wiki/FR:Map_Features


Pour connaître comment bien écrire les noms des rues (toponymie), je vous invite à aller voir la 
page OSM sur la toponymie des lieux.

Étape 5 : Validation du travail 
Nous allons vérifier  si tout ce que nous avons fait  est valide (grâce au plugin  Validator!) déjà 
intégré dans JOSM. Pour ce faire, cliquez sur le bouton en forme de V dans le menu à gauche. A 
droite un onglet s'ouvre et vous montre les problèmes s'il y en a.

Bouton validator     :  

• JOSM n'est pas content si vous n'avez pas mis de nom aux rues : Unamed ways (3) 
• JOSM n'est pas content si vous n'avez pas mis de type aux routes : Untaged ways (1) 

NLDR     :   Si vous ne mettez pas de type de route, la route n'apparaîtra pas sur OpenStreetMap.

Via un clic droit sur le problème (dans le tableau à droite de l'écran), vous pouvez zoomer sur le 
tronçon qui pose problème. Ce dernier se met en alors surbrillance :

Pour palier ce problème il faut ajouter un nom et un type. Parfois il n'y a pas de nom mais il y a 
toujours un type ! Corrigez donc au moins les erreurs de type en sélectionnant le tracé en question et 
en ajoutant un « highway  + ? »  

Ajouter également la source de votre travail en ajoutant un attribut « Source » + « cadastre-dgi-fr 
source :  Direction Générale des Impôts - Cadastre.  Mise à jour :  2011» ou  par exemple votre 
pseudo si le tracé est issu de votre GPS ! Plus loin, lors de l'envoi,  l'outil vous demandera s'il doit 
ajouter la source du cadastre si vous n'avez rien mis. 

NLDR     :   Attention, l'ajout de la source est une obligation légale si vous travaillez sur le cadastre.

Puis une fois satisfait, on peut enregistrer son travail : File => Save As... (Fichier => Enregistrer 
sous). 

http://wiki.openstreetmap.org/wiki/FR:Toponymie


Étape 6     :   Mise en ligne de votre contribution 

Mais tout ce que vous avez fait n'est pas sur le Internet et personne sauf vous ne peut en profiter ! 
Quelle tristesse n'est-pas ? Pour ce faire, il faut créer un compte sur le portail Openstreetmap.org.
Une fois que vous êtes enregistré et que vous avez validé votre inscription sur votre mail, on peut 
envoyer notre travail sur le Internet !

Pour ce faire :  File => Upload Data (Fichier => Envoyer les données) ou en appuyant sur la 
flèche verte signifiant « Envoyer les données ! »  :

Le logiciel vous signale s'il y a des avertissements, des erreurs. Si des avertissements sont stipulés 
comme par exemple l'absence de nom d'une rue, vous pouvez continuer (même s'il est recommandé 
de l'ajouter si vous le connaissez). Ensuite, il suffit de faire « Ok » et rentrez votre utilisateur et mot 
de passe. Puis de nouveau faites « OK ».

A ce moment là, vous envoyez toutes les modifications et créations que vous avez produites ! Ne 
vous déconnectez pas d'Internet et attendez l'envoi complet. Cela peut être court ou assez long selon 
le nombre d'objets et votre connexion.

Il ne reste plus qu'à attendre la mise à jour sur le serveur Openstreetmap (entre quelques minutes à 
plusieurs heures...) ! Pour ma part, j'ai attendu un peu plus de douze heures pour que tous les zoom 
de la carte soient modifiés.

A ce moment là si vous observez des problèmes vous pourrez réimporter votre travail  (à partir  
d'OpenStreetMmap) et faire des modifications puis renvoyer de nouveau ! 

VI] utilisation de l'imagerie Bing
Tout ce que nous venons d'apprendre va nous servir dans l'utilisation de l'imagerie de Bing. Cette 
imagerie mise à disposition par Microsoft,  est en quelque sorte des photos prises du ciel.  Cette  
imagerie nous permet d'apercevoir les détails d'un territoire. Il ne restera plus qu'à dessiner ce qu'il 
nous intéresse.
L'avantage certain de cette méthode, c'est  qu'elle est  très  didactique.  En effet,  elle permet  une 
bonne vision d'ensemble et aujourd'hui on est assez habitué à naviguer sur une vue de ce type. 
Attention tout de même car cette imagerie n'est pas souvent mise à jour et des distorsions existent. 
Les nouvelles constructions n’apparaîtront donc pas toujours. Pour connaître la date de la photo sur 
JOSM et donc connaître la fiabilité de celle-ci, vous pouvez faire un clic droit sur la photo et choisir 
« Afficher l'information de la tuile ». Des informations apparaîtront sur votre écran. 

On remarque que notre photo est assez vieille (2003 – 2006)     :  

Une autre solution pour connaître la date consiste à aller se renseigner sur ce site : mvexel

http://mvexel.dev.openstreetmap.org/bing/
https://www.openstreetmap.org/user/new


Pour autant, je vois deux utilisations intéressantes. 

La première, est la possibilité de dessiner directement sur cette image (les routes, les chemins...). La 
seconde utilisation est de pouvoir corriger si besoin les erreurs du cadastre. En plus, si comme nous 
l'avons vu, votre commune n'a pas de cadastre vectorisé, vous pourrez travailler de cette manière. 
Encore  une  méthode  donc  pour  contribuer  sans  dépenser !  Sans  plus  attendre,  passons  aux 
paramétrages.

Imagerie Bing avec données OSM :

Paramétrages     :  

Pour utiliser les imageries Bing, il est nécessaire de changer de projection (cf. : IV, Étape 3). De ce 
fait, le cadastre ne pourra pas être superposé à la vue aérienne. Pour ce faire, retournons dans le 
paramétrage, Edit => Preferences (Modifier => Préférences) puis dans l'icône de la grille. Dans 
la  liste,  choisissez  dans  la  liste  projection :  MERCATOR.  Il  s'agit  pour  information,  de  la 
projection du GPS.

A partir de là, retournez dans le logiciel et trouvez dans le menu l'onglet « Imagerie ». Cliquez, sur 
Bing Sat. Comme par  magie,  l'imagerie  Bing  apparaît.  Et  vous  pouvez  dessiner  comme nous 
l'avons appris précédemment. C'est pas mal n'est-ce pas ! Pour la source, pensez à citer l'utilisation 
de l'Imagerie Bing.

NLDR     :   Si vous souhaitez de nouveau utiliser le cadastre, pensez à changer de projection.



VII] Et avec le GPS ? 
Vous pouvez très bien travailler avec le GPS, mais, pour ma part, je pense qu'il est plus opportun de 
travailler avec le fond cadastre et les données d'OpenStreetMap sur les zones urbaines. Je réserverai 
le GPS pour les chemins de randonnées lorsque je fais du VTT ou de la randonnée où là, le cadastre 
est  difficilement  exploitable!  Le  GPS  peut  être  quand  même  utilisé  dans  les  zones  urbaines, 
notamment sur les zones où le cadastre n'est pas vectorisé ou sur des grandes distances (en voiture 
par exemple).

Exemple avec une trace GPS :

Le principe reste identique cependant, nous allons voir quelques particularités avec le GPS.
Tout d'abord il faut faire en sorte d'extraire vos données au format GPX. Mapsource (outil Garmin) 
le permet  avec les  GPS Garmin. Il  existe aussi  des logiciels  gratuits  permettant  d'effectuer  des 
transformations comme le célèbre outil  GPSBabel. Vous pouvez aussi manipuler le format GPX 
avec le logiciel libre QGIS mais il s'agit orienté SIG ( Système d'Information Géographique).

Une fois le fichier exporté et épuré des problèmes potentiels (comme l'arrêt casse 
croûte  ou  un  double  passage),  nous  pouvons  importer  la  trace  sur  JOSM. 
Évidemment, les problèmes peuvent aussi être traités sur JOSM.

Si vous n'avez pas de GPS pour les sports extérieurs et que vous souhaitez être 
guidé, je vous invite à lire le comparatif entre un GPS tactile (Oregon 450T) et 
un non tactile (Colorado 300) sur cette page. Bonne lecture ! Sinon, vous pouvez 

vous procurer un GPS basique ou même utiliser le GPS de votre voiture en enregistrant la trace. 
Regardez dans les paramétrages de votre GPS.

Le bouton ci dessous permet d'importer le fichier GPX :

Une fois importé dans le logiciel, votre trace apparaît dans 
JOSM (à droite)  en tant qu'un nouveau  Layers (calque de 
données).  N'oubliez  pas  de  télécharger  les  données  déjà 
disponibles (cf. étape 5). Ne vous acharnez pas à essayer de 
modifier  la  trace de suite.  Par défaut,  vous ne pouvez pas 
modifier directement votre tracé. 

Pour ce faire, il faut faire un clic droit sur votre fichier puis 
sélectionner  « Convert  to  data  layer »  (Convertir  en 
calque de données) dans la zone layer du logiciel.

Vous vous retrouver donc avec deux « layers », deux calques 
ou trois si vous avez ajouté le cadastre. Un layer qui contient 
les données d'OpenStreetMap et un autre qui contient votre 
GPX maintenant modifiable. 

Lorsque vous êtes sur une couche l'autre n'est pas modifiable. 
Pour passer d'une à l'autre, utilisez le bouton suivant qui se 

situe dans la barre d'outils des couches :

http://www.partir-en-vtt.com/test/voir_test.php?voir_test=78
http://www.gpsbabel.org/


Barre d'outils des layers (couches) :

Si vous souhaitez fusionner les deux couches, vous pouvez utiliser ce bouton :  
Une question vous demandera alors la destination de la fusion. Répondez alors que vous souhaitez 
ajouter votre fichier dans le « calque de données 1 ».

Pour récapituler les différents outils de gauche à droite) :

• Monter la couche, 
• Descendre la couche, 
• Rendre modifiable la couche, 
• Rendre visible/invisible la couche, 
• Fusionner deux layer en décidant d'envoyer une couche vers une autre, 
• Dupliquer une couche, 
• Supprimer la couche. 

Concernant les données attributaires sur les chemins de randonnées ou de VTT     :  

Pour le type de chemin « randonnée » et « VTT » on utilise « path ». Path est utilisé dans le cas 
d'un chemin ou un 4x4 ne pourra pas passer.

• Petit chemin : « Highway » + « path » 

NLDR     :   La catégorie « Track » est un chemin également mais ou un 4X4 peut en théorie circuler 
(gros chemin de forêt).

On peut ajouter aussi le type de surface pour un type route « track » via la balise optionnelle : 
« tracktype » 

Puis les paramètres sont « grade 1-5 » grade2 étant par exemple « Une surface en gravier ou en 
terre/sable compact ». Le wiki OSM sur les objets donne une photo de chaque type.

Concernant les points de vues, si vous arrivez sur un belvédère, vous pouvez ajouter un point (un 
nœud) avec l'outil ligne en faisant un double clic gauche (ou in clic puis en utilisant la touche 
ECHAP). Puis, en sélectionnant ce point et en ajoutant comme attribut « viewpoint » Bien-sûr vous 
pouvez également ajouter un nom grâce « name » +  « Le nom du point de vue »...

Il y a tellement de possibilité d'enrichir votre carte que je vous invite de nouveau à aller sur la page 
 feature  d'OpenStreetMap.

http://wiki.openstreetmap.org/wiki/FR:Map_Features
http://wiki.openstreetmap.org/wiki/FR:Map_Features


 Capture du village de Gevingey après mon intervention sur JOSM pour OSM 
(OpenStreetMap) :

Ah, avouez, c'est quand même plus sympa avec les routes avec leurs nom, et quelques chemins (en 
pointillé brun).

Maintenant, si vous le voulez bien,  voici une petite astuce qui fait office d'une seconde vérification 
de vos routes et chemins : Géofabrik outil de "routage"

Ce site permet de voir si toutes vos  routes sont  raccordées.  J'ai  pu me rendre compte de mes 
erreurs sur ce sujet en y allant :

Les petits points rouges et oranges indiquent les lieux des différents problèmes. Il s'agit à chaque 
fois d'un mauvais accrochage entre les différents tronçons. Pour pallier à cela, ouvrez JOSM puis 
importez les données sur votre secteur. Ensuite, utilisez les outils de modifications et d'ajout de 
lignes pour accrocher tout ça correctement !
Si l'on retourne sur le logiciel JOSM et que l'on zoom fortement sur le secteur qui pose problème, 

http://tools.geofabrik.de/osmi/?view=routing


on se rend compte que la route est non raccordée à un autre tronçon de route. Ceci ne se voit pas  
forcément sur la carte finale d'OpenStreetMap mais pour faire ce que l'on appelle du « routing » 
c'est embêtant car il sera impossible de passer par cette route étant donné qu'elle est coupée du reste 
du réseau. Le routing permet à votre GPS de vous créer un chemin pour aller d'un point A à un 
point B en vous disant « tournez à droite », « tournez à gauche ».

Après quelques modifications     :  

  

On distingue encore une erreur mais grâce à ces corrections, on peut maintenant utiliser vos routes 
pour tracer un parcours automatiquement sur Mapsource par exemple ou directement sur votre GPS. 

VIII] Créer une belle carte PDF avec vos données et celles des autres 

Vous avez créer vos données et vous avez envie 
d'imprimer une carte de votre village ou de votre 
quartier.  Pour  les  Linuxiens,  vous pouvez  créer 
une carte maison via ce tutoriel. 

Pour les autres et les plus pressés, vous pouvez 
générer votre carte sur le site Internet d'Osmatic 
au  format  PNG,  SVG  (Vectoriel)  ou  PDF  en 
passant  par  l'onglet  « Créer  une  carte ». 
Sélectionner  votre  ville  (Bouton  radio :  Limite 
administrative) ou un secteur (bouton radio : zone 
géographique) 

Pour  le  choix  géographique,  zoomez  sur  votre 
secteur  et  sélectionner  précisément  votre  zone 
grâce  au  bouton  «  CTRL +  cliqué-déplacé » 
pour créer un rectangle. 

Dans  les  deux  cas  finissez  par  cliquer  sur 
« Générer ».Votre carte se génère alors selon une 
file  d'attente.  Enfin,  profitez-en  un  maximum, 
c'est gratuit, libre, distribuable à volonté ! Merci 
qui ?  Merci  OSM,  merci  aux  contributeurs  et 
donc à vous.

http://www.maposmatic.org/new/
http://www.geotribu.net/node/267


Notre belle carte de Gevingey avec les bâtiments :

IX] Conclusion :
J'espère avoir  parcouru au mieux ce logiciel  dans ses fonctions de bases.  Une fois  lancé,  vous 
découvrirez au fur et à mesure les capacités énormes de ce logiciel. Vous pourrez aussi vous rendre 
compte de tout l'intérêt à contribuer pour cette cartographie libre. S'il fallait retenir quelque chose 
de ce tutoriel, ce serait de comprendre que contribuer à OSM, ça ne coûte rien, que ça profite à tout  
le monde et que ça prend un peu de temps. Ce temps, n'est par-contre nullement perdu car le résultat 
est  bien là,  concret  !  Grâce à OSM, on devient  acteur  pour  son  territoire  et  avouons le,  c'est 
gratifiant !

Si vous avez des interrogations ou remarques, n'hésitez pas à m'en faire part afin que je puisse 
améliorer ce tutoriel. Bien-sûr, je vous invite fortement à ouvrir des discussions sur le forum de 
www.partir-en-vtt.com et à suivre la mailing liste d'OSM si le cœur vous en dit. Enfin, que ce soit 
avec le cadastre, l'imagerie Bing ou avec votre GPS, je vous remercie d'avoir lu ce tutoriel et vous 
souhaite un bon mapping sur JOSM !

Sportivement, Loïc ,

Dans un projet comme OSM, si tous le monde y met un peu du sien, c'est tous le monde qui y gagne énormément!
Bon mapping !

http://www.partir-en-vtt.com/
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